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Quick Start Guide

This guide describes some of the features of your DYMO® LabelManager® 
Wireless PnP label maker. Read the following sections for information about 
using your label maker.

 Registering Your Label Maker

 Getting to Know your Label Maker

 Inserting the Battery Pack

 Removing the Battery Pack

 Inserting the Label Cassette

 Connecting the Label Maker to your Computer

 Starting the Built-In Software

 Printing Labels with the Built-In Software

 Checking the Label Maker Status

 Charging the Battery Pack

 Configuring the Label Maker as a Wireless Printer

 Adding the Wireless Printer

Registering Your Label Maker
Visit www.dymo.com/register to register your label maker online. During the 
registration process, you will need the serial number, which is located above the 
label cassette inside the label maker. See Figure 1 on page 2.

Register your label maker to receive these benefits:

 Email notification of free software upgrades

 Special offers and new product announcements

For complete information on using your label maker, download the full 
LabelManager Wireless PnP User Guide at userguides.dymo.com.
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Getting to Know your Label Maker
Become familiar with the features shown in the following figure. 

Figure 1 
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Inserting the Battery Pack

The label maker is powered using a rechargeable lithium-ion polymer (LiPo) 
battery pack. 

Make sure the USB cable is disconnected before handling the LiPo 
battery pack.

To insert the battery pack

1 Press  and pull to open the 
side cover of the label maker.

2 Insert the battery pack into the 
battery compartment as shown 
in Figure 2.

Make sure to read the LiPo 
Safety Precautions found on 
page 12.

Removing the Battery Pack

Remove the battery pack when the 
label maker will not be used for more 
than seven days.

Make sure the USB cable is disconnected before handling the LiPo 
battery pack.

To remove the battery pack

1 Unplug the USB cable.

2 Press  and pull to open the side cover of the label maker.

3 Remove the battery pack from the battery compartment.

Make sure to read the LiPo Safety Precautions found on page 12.

Figure 2 
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Inserting the Label Cassette
Your label maker uses DYMO D1 
label cassettes.

To insert the label cassette

1 Press  and pull to open the 
side cover of the label maker.

2 Make sure the tape and ribbon 
are taut across the mouth of the 
cassette and that the tape 
passes between the label 
guides. See Figure 3.

If necessary, turn the ribbon 
rewind spool clockwise to 
tighten the ribbon.

3 Insert the cassette and press 
firmly until the cassette clicks 
into place. See Figure 4.

4 Close the side cover of the 
label maker.

Figure 3 
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Connecting the Label Maker to your Computer
The label maker connects to your computer through the USB connection located 
on the back of the label maker. 

To connect the label maker to your computer

1 Plug one end of the USB cable into the label maker. See Figure 5.

2 Plug the other end into an available, powered 
USB port on your computer. 

The label maker must be connected to a 
powered USB port. The label maker may not charge 
or function properly when connected to a non-
powered USB port, such as those on some Mac 
keyboards or a non-powered USB hub.

Starting the Built-In Software

The built-in software resides on the label maker; no installation is required.

To start the software for Windows®

1 If necessary, press the power button to turn on the label maker.

Depending on Windows AutoRun or AutoPlay settings, the software may 
start automatically.

2 If the software does not start automatically, do one of the following:

• If the AutoRun or AutoPlay dialog box appears, follow the on-screen 
instructions to start the  DYMO Label Light software.

• If the AutoRun or AutoPlay dialog box does not appear, navigate to 
My ComputerDYMO W-PNP, and then click  DYMO Label 
Light.exe.

To start the software for Mac OS®

1 If necessary, press the power button to turn on the label maker.

The DYMO Wireless PnP volume appears on your desktop.

2 Double-click DYMO W-PNP to open the volume.

3 Double-click  to start the software.

Figure 5 
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Printing Labels with the Built-In Software

The following figure shows some of the features available in the software.

To print your first label

1 Click once on the label in the Edit area and type some text.

2 Click  to print the label.

To capture and insert an image from your desktop

1 Click  on the toolbar.

2 Drag the curser to draw a selection box around the area to capture.

The selected area is inserted into your label.

To take advantage of more advanced formatting features, click  in the built-in 
software to download and install DYMO Label™ v.8.5 or later from the DYMO 
Web site.

Insert text from
the Clipboard.

Select the
font, size, and
style for your

label text.

Create a
new label.

Match the label
width to the label

cassette in the
label maker.

Start advanced 
DYMO Label v.8 
software.

Rotate images 90 
degrees.

Choose to print 
a horizontal or 
vertical label.

Add a border 
around the label.

Choose a fixed length for the 
label or make the label resize 
automatically to fit the text.

Crop an image 
added to the label.

Change the units of 
measure or 
language settings.

Capture an area of the
screen and insert on

your label.

View the power
status of the
label maker.

Print a label.

Zoom the label.

Manage the 
label maker on your 
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Choose to automatically cut 
each label as printed or to 
only cut between print jobs.

Figure 6 
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Checking the Label Maker Status

The label maker status is displayed in the software window. The following table 
describes the possible states of the label maker. See Figure 6 on page 6.

Charging the Battery Pack

You can charge the battery pack by connecting the label maker to either the 
computer or the wall adapter. Fully charging the battery will take approximately 
two and a half hours when charged using the wall adapter and approximately 
eight hours when charged while connected to a powered USB port on your 
computer.

For best performance, fully charge the battery pack before using your 
label maker.

Make sure to read the LiPo Safety Precautions found on page 12.

To charge the battery pack from your computer

1 Connect the label maker to a powered USB port on your computer.

2 Turn on the computer. 

The battery pack will not charge if the computer is turned off or in sleep 
mode.

3 If the label maker is turned off, press the power button to turn the label 
maker on and start charging the battery pack.

The label maker must be connected to a powered USB port to charge the 
battery. The label maker may not charge or function properly when connected to 
a non-powered USB port, such as those on some Mac keyboards or a non-
powered USB hub.

   
Label maker is connected; battery pack is charging

   
Label maker is connected; battery pack is not charging

Label maker is not connected or is turned off

Label maker is connected; there is a problem with the 
battery pack
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To charge the battery using the wall adapter

1 Insert one end of the USB cable into the label maker. 

2 Insert the other end of the USB cable into the wall 
charger. See Figure 7.

3 Plug the wall adapter into a working power outlet.

4 If the label maker is turned off, press the power button 
to turn the label maker on and start charging the battery 
pack.

Configuring the Label Maker as a Wireless Printer
You can use your label maker either as a local printer connected to a powered 
USB port on your computer or as a networked printer on your wireless network.

You must have a network with a wireless router or access point to use your 
label maker as a wireless network printer.

Before configuring the label maker, you must determine the connection method 
to use to connect to your wireless network.

Refer to the documentation that came with your router or access point to 
determine the connection methods supported.

You cannot use the label maker as a wireless network printer while the label 
maker is connected to a USB port on your computer.

Connection Method Description

Standard Use this method if you want the Wireless Setup tool to 
automatically detect your network. Your network will 
be detected automatically and you will be prompted 
to enter your security information.

Advanced Use this method if you want to enter all network 
information manually. The Wireless Setup tool will not 
automatically detect your network.

Use this method only if you are very familiar with your 
wireless network, or if the other methods are 
unsuccessful.

Figure 7 
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To configure the printer on your wireless network

1 From within the built-in software, click . 

The Wireless Setup tool starts.

2 Follow the steps in the Wireless Setup tool.

 The wireless status light located on the top of the label 
maker turns solid blue when the label maker is 
successfully connected to a wireless network. See 
Figure 8.

3 After configuring the label maker as a wireless printer, 
disconnect the USB cable from your computer.

4 Place the printer in an easily accessed location.

5 Plug the USB cable into the wall adapter and then plug the wall adapter into 
a wall outlet.

6 If necessary, press the power button to turn the printer on.

Adding the Wireless Printer
To print labels to the networked printer, you must download and install DYMO 
Label™ v.8.5 or later from the DYMO Web site, and then add the printer to your 
computer.

To add the wireless printer to a Windows computer

1 Download DYMO Label™ v.8.5 or later from the DYMO Web site at 
WirelessPnP.dymo.com.

2 Close all open Microsoft Office applications.

3 Double-click the Installer icon.

After a few seconds, the installation screen appears.

4 Click Install and follow the instructions in the installer.

When the software installation is complete, you are prompted to connect 
your printer.

5 Without connecting your printer, click Finish, and then start the software.

Figure 8 
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6 Do one of the following:

• If this is the first DYMO label printer installed on the computer, click Yes 
when prompted by the software to add the label maker as a wireless printer.

• If a DYMO label printer is already installed on the computer, choose Add 
Network Printer from the File menu.

7 Follow the instructions in the Add Network Printer tool.

To add the wireless printer to a Mac OS® system

1 Download DYMO Label™ v.8.5 or later from the DYMO Web site at 
WirelessPnP.dymo.com.

2 Double-click the Installer icon and follow the on-screen instructions.

When the software installation is complete, you are prompted to connect 
your printer.

3 Without connecting your printer, click Finish, and then start the software.

4 Do one of the following:

• If this is the first DYMO label printer installed on the computer, click Yes 
when prompted by the software to add the label maker as a wireless 
printer.

• If a DYMO label printer is already installed on the computer, choose Add 
Network Printer from the File menu.

5 Follow the instructions in the Add Network Printer tool.

To print to the label maker wirelessly

1 Restart DYMO Label software.

2 If you have more than one DYMO label printer installed, 
do the following:

a Click the printer image in the DYMO Label software 

Print area.

All of the label printers that are installed on your 

computer are displayed.

b Select the LabelManager Wireless PnP (nnnnnnnnnnnn) printer.

3 Click  to print your label.
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For complete details on using the software, refer to the online Help or the DYMO 
Label User Guide.

From the Help menu in DYMO Label software, you can view the following:

 DYMO Label Help

 DYMO Label User Guide

 LabelManager Wireless PnP User Guide
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Safety Precautions for Lithium-Ion Polymer Rechargeable Battery Pack

Inaccurate handling of a lithium-ion polymer rechargeable battery pack may 
cause leakage, heat, smoke, an explosion, or fire. This could cause deterioration 
of performance or failure. This may also damage the protection device installed in 
the battery pack. This could damage equipment or injure users. Thoroughly 
follow the instructions below.

While Charging the Battery Pack

Danger

Warning

Caution

When Discharging the Battery Pack

Danger

Caution

 When charging the battery pack, use dedicated chargers and follow the 
specified conditions.

 Do not connect directly to an electric outlet or cigarette lighter charger.

 Do not use or store battery pack close to fire or inside the car where 
temperature may be over 60°C.

 Stop charging the battery pack if charging is not completed within the 
specified time.

 Thoroughly read this document before charging the battery pack.

 Do not charge in a place that generates static electricity.

 Battery pack can only be charged within 0°C~45°C temperature range.

 Use the battery pack only in the specified equipment.

 Do not use or store battery pack close to fire or inside the car where 
temperature may be over 60°C.

 Do not charge in a place that generates static electricity.

 Battery pack can only be used within -20°C~60°C temperature range.
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1-Year Warranty for Your DYMO Product
Your electronic DYMO product is sold with a 1-year warranty from the date of purchase 
against defects in material and workmanship. DYMO will repair or replace your product 
free of charge on the following conditions: 

1 Products returned under this warranty must be accompanied by a description of the 
defect together with a copy of the product’s proof of purchase and your full contact 
and delivery details: name, telephone, complete address – street, house number, 
postal code, city, country.

2 Products returned to DYMO must be adequately packaged. DYMO will accept no 
liability for goods lost or damaged in transit from the customer.

3 Products must have been used strictly in accordance with operating instructions 
supplied. DYMO will have no liability for defects caused by accident, misuse, 
alteration or neglect.

4 DYMO accepts no liability for any consequential loss, damage or expense of any kind 
resulting from the machines or accessories or the use thereof, save that liability for 
death or bodily injury caused by such products is not excluded.

5 DYMO label printers are designed for use only with DYMO-branded labels. This 
warranty does not cover any malfunction or damage caused by the use of third-party 
labels.

6 This warranty does not affect your statutory rights as a consumer.

What to do if your product is defective?
DYMO offers you the following service options:

 DYMO Web site: In most situations a visit to www.dymo.com will give you the right 
assistance. In the Customer Support area, you will find information about your DYMO 
product, such as Frequently Asked Questions and solutions to known problems. The 
User Guide also gives you additional information.

 Dealer: Your DYMO dealer can help you to determine the exact nature of the 
problem and assist you further.

 DYMO Help Desk: You can also contact the DYMO Help Desk where an associate 
will help you to determine the exact nature of the problem and advise you what to do 
next:

US 1 877 724 8324

Intl +44 203 564 8356

 Repair Center: You can send your defective product to a DYMO repair center 
(please see the above-mentioned conditions 1 and 2 on how to replace a defective 
product). The address of your nearest DYMO repair center can be found at 
www.dymo.com or you can contact the DYMO Help Desk.
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